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Aisle Number

The name or number of the location within the store where the item can be found.    This field is used 
by the Store Shopping List to determine the order    in which items appear on the list.    Aisle "numbers" 
may consist of any combination of letters and/or numbers.



As Of

The date that the price information was last modified.    This field is filled in automatically.



Best Price
The best (cheapest) unit price among all the stores with prices for the item.    When printing Store 
Shopping Lists, an item's "buy" mark will appear on the list for the store with the best price.



Best Price Color
The color used on the main display to denote the best price for an item.



Buy Buttons

The buttons (Item, All, and Clear) used to control the buy marks for items.    The Item button toggles 
the Buy Mark for the currently selected item in the Items List.    The All button sets the Buy Mark for 
every item in the Items List and the Clear button clears every item's Buy Mark.



Buy Mark
The mark used to indicate that an item needs to be bought.    In the Items List of the main display, a 
letter (B) is used; on printed and displayed lists, a check mark (Ö) is used.



Configuration File
The file (SHOPPER.CFG) in which is stored the most-recent customized configuration.



Context File
The file (SHOPPER.CTX) in which is stored the most-recent values representing the location of the 
main display window and the size and location of the list display window.



Coupon Buttons

The buttons (Item, All, and Clear) used to control the coupon marks for items.    The Item button 
toggles the Coupon Mark for the currently selected item in the Items List.    The All button sets the 
Coupon Mark for every item in the Items List and the Clear button clears every item's Coupon Mark.



Coupon Mark
The mark used to indicate that you have a coupon for an item.    A letter (C) is used.



Current Data File
The file from/to which the current data tables contents was read/written.



Default Units
The default units is the units designation that gets assigned initially when new items are created.    The 
units designation used as the default may be specified from the configuration screen.



Item
The name of something you buy from a store and its associated pricing unit, e.g., "ea", "box", "gal", 
etc.



Item Price Comparison

The list which shows side-by-side price comparisons of an item at two or more stores.



Items List

The list box on the main display which contains the item names arranged in alphabetical sequence.



Master Shopping List

The alphabetized list of all item names with an associated checkbox, suitable for recording the items 
which need to be bought.    We hang our Master Shopping List on the refrigerator.



Number of Containers

The number of bottles, cans, boxes, etc., which need to be purchased at one time.    Some discount 
stores require that you purchase multiples of an item whereas most grocery stores allow you to 
purchase single packages.



Preferred Store

If set, this checkbox indicates that the current store is the one on whose Store Shopping List the 
current item is to always appear, irrespective of which store has the best (cheapest) price.    Only one 
store can be the "preferred store".



Price

The combination of    number of containers, container size, and unit price for an item which is valid at a
single store.    An item's aisle number, "as of" date, and "preferred store" indicator are also considered 
part of the price information.    It is the existence of a price that allows an item to appear on a Store 
Shopping List.



Price Buttons
{bml pricebut.bmp

The buttons (New and Delete) used to create or delete a price entry for the current store.    When the 
New button is activated, a default price entry is created.    You must, of course, edit it to reflect the 
item's correct number of containers, container size, and total price.    The Delete button removes the 
current item's price entry.



Shareware
A fully-functional copyrighted program which you are free to use, at no charge, for a trial period.    If, 
after a reasonable time, you continue to use it, you must register it and pay a fee to the program's 
author.



Shopping Basket Comparison

The list showing side-by-side comparisons of item prices at two or more stores.    This list differs from 
the Item Price Comparison in that only items with prices at all of the selected stores are included.    
Since most stores use attractively-priced "loss leaders" in their advertising, this list provides a 
convenient means of comparing store prices on a broader scale.



Size

The number of an item's pricing units which are contained in a single container.    For example, the 
"size" of a 32 oz. bottle of ketchup is "32".



Speed Buttons

The buttons located across the top of the main display which provide an alternate method of initiating 
commonly used menu options.



Store
The name of a place at which you shop.



Store Shopping List

The list showing, for each selected store, either all the items for which a price at that store exists or 
only those items which have been "buy" marked.



Stores List

The drop-down list on the main display used to choose which store's price is displayed when an entry 
in the Items List is selected.



Total Price

The amount you would pay at the associated store for the number of containers, each of "size" units, 
shown.



Unit Price

The computed price per unit of an item.



Units
The designation, e.g., "cans", "boxes", "oz", "ea", "gal", etc., identifying the quantity of an item for price 
comparison purposes.



Units List

The drop-down list on the main display used to choose the pricing units for the currently-selected 
Items List entry.



Introduction
Windows® Shopper is a comprehensive set of tools which make it easier to manage that sizable 
portion of your family's budget represented by groceries and household maintenance items.    Its 
database provides an alternative to a spreadsheet for maintaining comparative prices.    Its Master 
Shopping List will make it more likely that the items which need to be bought are purchased during 
scheduled store visits, thereby reducing the number of inefficient "emergency" trips.    The Store 
Shopping Lists, which automatically separate your needed items into smaller lists for each store and 
list the items in aisle number sequence, will make the scheduled shopping trips faster and more 
pleasant.

Written specifically for the Windows environment, Windows® Shopper uses the features of the 
graphical user interface to simplify entry and management of its data and takes advantage of Windows
to adapt to your computing environment.



Requirements
Microsoft Windows 3.x in Standard or Enhanced mode.
EGA or higher monitor.
Mouse
The library files (included with Windows® Shopper):

CMDIALOG.VBX
COMMDLG.DLL
THREED.VBX
VBRUN300.DLL

Approximately 0.86b of hard disk storage:

CMDIALOG.VBX 18,688
COMMDLG.DLL 89,248
SAMPLE.SHP 15,135
SHOPPER.EXE 180,823
SHOPPER.HLP 92,870
THREED.VBX 64,432
VBRUN300.DLL 398,416



Getting Started
Windows® Shopper was created using tools specifically designed to develop Microsoft Windows 
applications.    As a result, the user interface it employs will appear familiar to anyone who already 
feels comfortable with Windows itself and other applications written specifically for Windows.    Should 
you require additional information on the use of the keyboard and mouse or how drop-down menus, 
dialogue boxes, list boxes, option boxes, etc., are used, please refer to "Part 1 Windows 
Fundamentals" of your Microsoft Windows® User's Guide.    There are a few cases where non-obvious
keyboard or mouse shortcuts have been implemented in Windows® Shopper to make it a little easier 
to accomplish some tasks; these shortcuts are discussed under their respective topics.

Setting Up Your Database

Printing a Master Shopping List

Marking Items to Buy

Marking Items with Coupons

Printing Store Shopping Lists

Updating Item Prices



Setting Up Your Database
It's important to remember that you can make changes of any nature to your Windows® Shopper 
database at any time.    Of course, you can't prepare lists using information that hasn't been entered 
yet, but you needn't worry about a marathon data entry session before you can even begin.

Start with a recent shopping list and enter just the items on it.    With each successive shopping trip, 
you can user your shopping list and the resulting cash register tape to expand your database.    In no 
time at all, you'll have a comprehensive list of the items you buy regularly, just exactly the ones 
Windows® Shopper handles best.

A small sample database (the file "SAMPLE.SHP") has been provided so you can see how we set up 
our database initially.    Of course, our database has undergone a lot of modification since this sample 
was created.

Items

Units

Stores

Prices



Items
Editing the list of items is performed from the Edit Items window.    From the main display, choose the 
Edit Items option of the Edit menu or select the I speed button.    The Edit Items window will be 
presented.

Add a New Item

Edit an Item    Name

Delete an Item

Assigning a Units Designation



Add a New Item
To add previously undefined items, select the New button in the Edit Items window.    When the Add 
New Item window is presented, type in the item description and, when the description is the way you 
want it, select the OK button.    When the Edit Items window is activated, you'll notice that the new item
description is now contained in its list.    Selecting the Cancel button in the Add New Item window will 
abandon the operation.



Edit an Item Name
To edit the description of an existing Item, select the Edit button in the Edit Items window (or double-
click on the item in the Edit Items window list).    When the Edit Item window is presented, correct the 
item description using standard Windows text editing techniques to make the description appear the 
way you want.    The clipboard can also be used to cut and/or paste text.    Selecting the Cancel button 
in the Edit Item window will abandon the operation, leaving the item description as it was.



Delete an Item
To delete an Item, select the Delete button in the Edit Items window.    You will be prompted for 
confirmation of your intent to delete the item.



Assigning a Units Designation
When a new item is created, it is automatically assigned the default units designation.    You may wish 
to change the units designation assigned to an item.    This is performed from the main display by 
selecting the desired item in the Units and then choosing the desired units designation from the drop-
down Units List.



Units
Editing the list of units is performed from the Edit Units Designations window.    From the main display, 
choose the Edit Units option of the Edit menu or select the U speed button.    The Edit Units 
Designations window will be presented.

Add a New Unit

Edit a Units Designation

Delete a Units Designation



Add a New Unit
To add previously undefined units designation , select the New button in the Edit Units Designations 
window.    When the Add New Units window is presented, type in the units designation and, when the 
designation is the way you want it, select the OK button.    When the Edit Units Designations window is
activated, you'll notice that the new unit designation is now contained in its list.    Selecting the Cancel 
button in the Add New Units window will abandon the operation.



Edit a Units Designation
To edit an existing units designation, select the Edit button in the Edit Units Designations window (or 
double-click on the units designation in the Edit Units Designations window list).    When the Edit Units 
window is presented, correct the units designation using standard Windows text editing techniques to 
make the designation appear the way you want.    The clipboard can also be used to cut and/or paste 
text.    Selecting the Cancel button in the Edit Units window will abandon the operation, leaving the unit
designation as it was.



Delete a Units Designation
To delete a units designation, select the Delete button in the Edit Units Designation window.    You will 
be prompted for confirmation of your intent to delete the units designation.



Stores
Editing the list of stores is performed from the Edit Store Names window.    From the main display, 
choose the Edit Stores option of the Edit menu or select the S speed button.    The Edit Store Names 
window will be presented.

Add a New Store Name

Edit a Store    Name

Delete a Store



Add a New Store Name
To add previously undefined store names, select the New button in the Edit Store Names window.    
When the Add New Store window is presented, type in the store name and, when the name appears 
the way you want it, select the OK button.    When the Edit Store Names window is activated, you'll 
notice that the new store name is now contained in its list.    Selecting the Cancel button in the Add 
New Store window will abandon the operation.



Edit a Store Name
To edit the name of an existing store, select the Edit button in the Edit Store Namess window (or 
double-click on the store name in the Edit Store Names window list).    When the Edit Store window is 
presented, correct the store name using standard Windows text editing techniques to make the name 
appear the way you want.    The clipboard can also be used to cut and/or paste text.    Selecting the 
Cancel button in the Edit Store window will abandon the operation, leaving the store name as it was.



Delete a Store
To delete a store name, select the Delete button in the Edit Store Names Window.    You will be 
prompted for confirmation of your intent to delete the store name.



Prices
For Windows® Shopper to retain price information, you must specify the item and the store to which 
the price information pertains.    Editing of price information is performed directly from the main display.

Add a Price

Edit a Price Information

Delete a Price



Add a Price
To create a new price for an item/store, select the New Price button on the main display.    A new price 
entry with default values will be created.    Edit the values as necessary by selecting the desired field 
and simply typing the new value into it..



Edit Price Information
Select the price information field with the mouse or TAB key and simply type in the desired value.

Marking the Preferred Store checkbox will tell Windows® Shopper that you wish the current item to 
always appear on the Store Shopping List for the    current store, irrespective of which store has the 
best (cheapest) price for the item.    Only one store can be the "preferred store".



Delete a Price
To delete an existing price, select the Delete Price button on the main display.    You will not be 
prompted before the price information is deleted.



Printing A Master Shopping List
As long as at least one item has been defined, you may generate a Master Shopping List.    This is the 
one we hang on our rerigerator instead of the old envelope we used to scribble on.    We put an "X" in 
the checkbox alongside the items we need to buy and write additional items on the bottom of the list.



Marking Items to Buy
When we're ready to go shopping, we take our Master Shopping List to the computer and use it to 
mark the items we need to buy.    We usually start the session by adding to the database the hand-
written items from the bottom of the list.    Then, from the main display, we mark the items we wish to 
buy: double-click on the item description in the Items List or use the Item Buy button.    This action will 
toggle the "buy" mark for the current item in the list.    The All and Clear Buy buttons set and clear, 
respectively, the "buy" mark for every item in the database.



Marking Items with Coupons
You can mark items as a reminder that you have a coupon(s) for the item.    This reminder, which will 
appear on the Master and Store Shopping Lists, will help you to remember to locate the coupon before
you leave for the store and to use the coupon at the store.

Managing the "coupon" marks is done in a manner similar to that for the "buy" marks: use the Item 
Coupon button to toggle the "coupon" mark for the currentl-selected Items List entry.    The All and 
Clear Coupon buttons set and clear, respectively, the "coupon" mark for every item in the database.



Printing Store Shopping Lists
Now you're ready to go shopping, so it's time to print the Store Shopping Lists.    Since you may wish to
maintain comparison prices for stores at which you won't shop, Store Shopping Lists are printed only 
for the list of stores you specify.    This list is part of the database and is edited by choosing the Select 
Shopping List Stores option of the Edit menu.    The Store Shopping Lists screen contains a list of all 
of the store names currently in the database.    Stores to be included when Store Shopping Lists are 
printed are indicated by an asterisk (*) to the left of the store name.    Use the Mark button on the Store
Shopping Lists screen to toggle this indicator.    The All and Clear buttons are used to set and clear, 
respectively, the selection of every store name in the list.

The Print Miscellaneous Items checkbox on the Store Shopping Lists screen controls whether or not 
a shopping list is to be printed containing those items which do not have any price (store) defined.



Updating Item Prices
While you are at the store, you may find it helpful to record/update pricing information directly on your 
store shopping list for the items you buy.    Remember, you need to record the number of containers 
and the size (in pricing units) of each container.

When you return home from the store it will take you only a few minutes to update your Windows® 
Shopper database with current pricing information for the items you bought.    Make sure the store at 
which you shopped is the one shown in the Store List and then select the desired item from the Items 
List (click on it).    Now, click on the price field you wish to update (or use the TAB key) and simply type 
in the new value.



Options (Menus)

File Menu

Edit Menu

List Menu



File Menu
As with most Windows applications, the File menu contains options relating to file and printer 
operations.

New

Open File

Import Shopper v1.x File

Save File

Save As

Delete File

Save Configuration

Printer Setup

Print

Statistics

Exit



New
The New command causes Windows® Shopper to begin the creation of a new database.    The 
existing database (if any) will be abandoned.    If the existing database has been modified since it was 
last saved, you will be warned of this condition and asked for permission to discard all existing data.



Open File
The Open File command causes Windows® Shopper to replace the existing database (if any) with the
contents of the file you specify.    This file becomes the current file.    If the existing database has been 
modified since it was last saved, you will be warned of this condition and asked for permission to 
overwrite the existing database.

The Speed Button labeled "O" may also be used to initiate the Open File command.



Import Shopper v1.x File
The Import Shopper v1.x File command allows Windows® Shopper to read data files created with 
Windows® Shopper v1.x (Windows® Shopper v2.x files are smaller and load faster).    As with the 
Open File command, this file becomes the current file.    If the existing database has been modified 
since it was last saved, you will be warned of this condition and asked for permission to overwrite the 
existing database.



Save File
The Save File command causes Windows® Shopper to write the current database to the current file 
on disk.    The Speed Button labeled "S" may also be used to initiate the Save File command.

This command is enabled only when the current database has been written to a file at least once.    In 
other words, if you use the New File command, the Save File command will be disabled until you 
have used the Save As command to specify the file which is to contain the database.



Save As
The Save As command causes Windows® Shopper to save the current database to the named file 
you specify.    This file then becomes the current file



Delete File
The Delete File command causes Windows® Shopper to delete the file you specify.    The Windows 
file selection common dialogue is used to choose the file.



Save Configuration
The Save Configuration command is enabled only when you change the Windows® Shopper 
configuration.    It causes Windows® Shopper to write the new configuration to the configuration file 
located in the current directory.



Printer Setup
The Printer Setup command causes Windows® Shopper to invoke the Windows® common dialogue 
that allows you to change printer settings, e.g., paper size, print orientation, etc., for either the default 
printer or any other installed printer.



Print
The Print command activates a sub menu allowing you to initiate printing of any of the Windows® 
Shopper lists.

Master Shopping List

Store Shopping Lists

Item Price Comparison

Shopping Basket Comparisons



Master Shopping List
The Master Shopping List command causes Windows® Shopper to initiate printing of the Master 
Shopping List.    You will be presented with the Windows® print initiation common dialogue which also 
provides access, if desired, to the Printer Setup common dialogue.



Store Shopping Lists
The Store Shopping Lists command causes Windows® Shopper to initiate printing of Store Shopping
Lists.    The stores for which shopping lists will be printed are controlled via the Select Shopping List 
Stores command under the Edit menu.

A dialogue box will appear allowing you to choose whether your Store Shopping Lists will contain only 
those items you have marked "to buy" or all items for which Windows® Shopper has a price for the 
store being printed.    Note that items for which Windows® Shopper does not have prices are listed on 
the Miscellaneous Store Shopping List.

You will be presented with the Windows® print initiation common dialogue which also provides access,
if desired, to the Printer Setup common dialogue.



Item Price Comparisons
The Item Price Comparisons command causes Windows® Shopper to initiate printing of the Item 
Price Comparison.    You will be presented with the Windows® print initiation common dialogue which 
also provides access, if desired, to the Printer Setup common dialogue.



Shopping Basket Comparisons
The Shopping Basket Comparisons command causes Windows® Shopper to initiate printing of the 
Shopping Basket (Store Price) Comparison.    The stores contained in this listing are specified via the 
Select Price Comparison Stores command under the Edit menu.

You will be presented with the Windows® print initiation common dialogue which also provides access,
if desired, to the Printer Setup common dialogue.



Statistics
The Statistics command causes Windows® Shopper to present a dialogue box containing the current 
Windows® Shopper version number, the database capacity and records in use, and the current 
database file name.



Exit
The Exit command is used to terminate Windows® Shopper execution.    If the current database or 
configuration has been modified and not saved when you choose this command, you will be informed 
of the condition and given the option to save or abandon the changes.

Using the standard Windows® Control Menu for Windows® Shopper's main screen to close the screen
also activates the Exit command.



Edit Menu
The Edit Menu contains those Windows® Shopper commands that are used to edit the current 
database or Windows® Shopper configuration.

Edit Items

Edit Stores

Edit Units

Select Shopping List Stores

Select Price Comparison Stores

Locate Item by Name

Configure Windows® Shopper



Edit Items
The Edit Items command allows you to add or delete items or to change the description of existing 
items.    The Speed Button labeled "I" also initiates the Edit Items command.

Item editing is done from a dialogue box that contains a list of the items currently contained in the 
database.    The New, Delete, and Edit buttons allow you to, respectively, define new items, delete the 
currently selected (highlighted) item, or change the currently selected item's description.    Specifying 
the description of new items or changing a current item's description is performed via an additional 
dialogue box.



Edit Stores
The Edit Stores command allows you to add or delete stores or to change the name of existing 
stores.    The Speed Button labeled "S" also initiates the Edit Stores command.

Store editing is done from a dialogue box that contains a list of the stores currently contained in the 
database.    The New, Delete, and Edit buttons allow you to, respectively, define new stores, delete 
the currently selected (highlighted) store, or change the currently selected store's description.    
Specifying the name of a new store or changing a current store's name is performed via an additional 
dialogue box.



Edit Units
The Edit Units command allows you to add or delete unit designations or to change existing unit 
designations.    The Speed Button labeled "U" also initiates the Edit Units command.

Unit designation editing is done from a dialogue box which contains a list of the unit designations 
currently contained in the database.    The New, Delete, and Edit buttons allow you to, respectively, 
define new unit designations, delete the currently selected (highlighted) unit designation, or change the
currently selected unit designation.    Specifying new unit designations or changing the current unit 
designation is performed via an additional dialogue box.



Select Shopping List Stores
The Select Shopping List Stores command is used to tell Windows® Shopper which stores you wish
it to include when you ask it to print Store Shopping Lists.    This feature allows you to print only 
selected shopping lists.



Select Price Comparison Stores
The Select Price Comparison Stores command is used to tell WindowsÒ Shopper which stores you 
wish it to include when it prints Shopping Basket Comparisons.



Locate Item by Name
The Locate Item by Name command allows you to locate items which contain a word or phrase.    
This is handy when you can't remember just how you worded an item name or when you want to find, 
say, all the "soup" items you have defined.    The Speed Button labeled "?" also initiates the Locate 
Item by Name command.

Locating items by name is done from a separate dialogue box.    You specify the word or phrase you 
wish to search for and, when you press the Search button, all items whose descriptions contain that 
word or phrase are listed.    The search is not case sensitive: specifying the word "peach" will match 
items with both "Peach" and "peach" in their descriptions.    By selecting one of the listed item 
descriptions and pressing the OK button, you will cause that item to be selected when you return to the
main Windows® Shopper screen.



Configure WindowsÒ Shopper
The Configuration command allows you to alter a number of Windows® Shopper features to meet 
your needs or preferences.    Once you change any Windows® Shopper    configuration item, the Save 
Configuration command under the File Menu is enabled. 



List Menu
The List Menu contains those commands that allow you to display each Windows® Shopper list on-
screen.

You may resize as you see fit the window used to display list information.    Windows® Shopper    
"remembers" the last size and position of the list window when it exits and restores it for you the next 
time it runs.    Furthermore, the list screen may be left open while you perform other Windows® 
Shopper functions, e.g., editing prices or item descriptions.

The list screen also contains a Print button allowing you to activate the Print sub menu command 
corresponding to the list being displayed.

Master Shopping List

Store Shopping Lists

Item Price Comparison

Shopping Basket Comparisons



Master Shopping List
The Speed Button labeled "ML" may also be used to activate the Master Shopping List Command.



Store Shopping Lists
The Speed Button labeled "SL" may also be used to activate the Store Shopping Lists command.

When you choose the Store Shopping Lists command, you will be presented with a dialogue box 
allowing you to select a single store for which a Store Shopping List is to be displayed.    Instead of 
choosing a store, you may elect to display the Miscellaneous Store Shopping List.    Next, you are 
presented with a dialogue box that allows you to specify whether the displayed Store Shopping List 
should contain only items marked "buy" or all items for which a price exists at that store.



Item Price Comparisons
The Speed Button labeled "IC" may also be used to activate the Item Price Comparisons command.



Shopping Basket Comparisons
The Speed Button labeled "BC" may also be used to activate the Shopping Basket Comparisons 
command.

Like its printed counterpart, the stores contained in this display are specified via the Select Price 
Comparison Stores command under the Edit menu.



Printing Considerations
Because Windows Shopper formats its printed output (using the font name, font size, and margins 
specified in the current configuration) to match the page size of the active Windows printer, you have a
high degree of control over the appearance of the printed lists.    Depending on your printer's 
capabilities, you may be able to print your Item Price Comparisons and Shopping Basket Comparisons
using a landscape orientation.    The length of your item names and units designations (also 
configurable) will affect how many columns can be accomodated on each Master Shopping List page.   
Experimentation will help you find the combination that is most satisfactory and pleasing.



Error Messages
We have tried very hard to prevent your getting into situations that Windows® Shopper can't deal with 
gracefully.    Because we cannot control the exact state of your computing environment, it is possible 
that some circumstances may arise which will prevent Windows® Shopper from performing as desired.
Some of these circumstances reflect conditions that simply must be corrected before Windows® 
Shopper can perform its functions.    In the event that you are presented with an error message that is 
not described here, it will usually indicate that the program has encountered a condition which we did 
not anticipate; in other words, you have discovered a "bug".    If you will make careful note of the 
circumstances leading up to the event, i.e., the exact steps you performed in the program, the exact 
values of the information involved, etc., and provide us with that information along with the Windows® 
Shopper version number, we will make every effort possible to correct the problem.

Printer Too Narrow

Printer Font Doesn't Exist

Can't Create AutoRedraw Image



Printer Too Narrow
Windows® Shopper attempts to print as much information across a single page as the current printer's
page size and orientation will allow.    Depending on the paper size and/or current print font and size, 
Windows® Shopper may not be able to fit the bare minimum information across or down the page.

Some suggestions should you encounter this message:

1. Try changing your print orientation to "landscape".

2. Try using a proportional, rather than monospaced, font.

3. Try using a smaller font size.

4. Try shortening your item descriptions and/or units designations.



Printer Font Doesn't Exist
This message indicates that Windows® Shopper's current printer font does not exist on your Windows 
system or that the active printer doesn't support the font.    Use Windows® Shopper's configuration edit
feature to choose an existing/supported printer font.



Can't Create AutoRedraw Image
This message, which may appear when you choose an option from the List menu, is an indication that
Windows® Shopper cannot acquire enough memory to generate an image buffer for the list window.    
Try terminating some other programs which are also running, thereby freeing up additional memory for
use by Windows Shopper.



Planned Enhancements
Now that the initial objectives for WindowsÒ Shopper have been completed, my immediate user 
community (read "spouse") has already made a number of suggestions for enhancements.    I have 
listed some of them below.    Perhaps you will share your suggestions as well.

Adding a "last purchase" date to the item database so that infrequently used items can be 
identified for deletion.



About Shareware
WindowsÒ Shopper is Copyright Ó 1993 by Thomas P. Wright.    All rights are reserved.

WindowsÒ Shopper is Shareware; this means that you are free to use the program for a reasonable 
trial period at no charge.    If, after the trial period, you continue to use the program you are expected 
register it.

To register your copy of WindowsÒ Shopper, please print and fill out the registration form.    Then mail 
it, along with your check or money order for the registration fee, to the address shown on the form.

When you register, you will receive:
the right to continue to use this program
a disk containing the current version of the program without the shareware message.
a printed manual

This is a fully functional copy of the program and has not been crippled in any way.    You may 
distribute this program and its associated files freely as long as all files are included and none of them 
have not been modified in any way.



Registration Form
You can print this form by selecting File/Print Topic from the Windows Help menu (above).    Most 
printers will be able to print it.    If yours doesn't, load the file "SHOPPER.REG" into NOTEPAD and 
print it from there.

WindowsÒ Shopper v2.x Registration Form
Name:

__________________________________________________________________

Company:
__________________________________________________________________

Address:
__________________________________________________________________

__________________________________________________________________

City: _____________________

State/Prov:_____ Zip/Postal Code:___________ Country:__________________

Phone: (_____)_____________

Electronic Mail Address (e.g., CIS ID):________________________________________

From where did you get your copy of WindowsÒ Shopper?

________________________________________________________________________

Preferred disk size (circle one): 5.25 3.5

Windows Shopper registration: $15.00

This gets you:
the right to continue to use this program
a disk containing the current version of the program without the shareware message
a printed manual

Shipping & Handling (US/Canada: $3; Other: $6): $___________

Total (US Funds): $___________

Checks must be drawn on a US bank and payable in US funds.    Canadian customers may use a 
Canadian Post Office Money Order. Please make sure it is in US funds.

Make checks payable to: Thomas P. Wright

Mail to: Thomas P. Wright
1983 Edgewater Dr.
Cincinnati, OH    45240




